
CHAPTER 1
Introducing ArcGIS 
LEARNING GOALS

•	 Get an introduction to ArcGIS®.

•	 Get an introduction to the ArcGIS Pro user interface.

•	 Learn to navigate maps.

•	 Work with tables of attribute data.

•	 Get an introduction to symbolizing and labeling maps.

•	 Work with 2D and 3D maps.

Introduction

A
rcGIS is an integrated collection of geographic information system (GIS) software 

developed by Esri® that works seamlessly across desktop computers, the internet, 

and mobile devices. The tutorials in this first chapter will familiarize you with a major 

component of this suite: ArcGIS Pro. ArcGIS Pro is a 64-bit desktop GIS application that 

uses a ribbon interface for 2D and 3D map authoring, analysis, and web publishing. You’ll 

use additional ArcGIS apps in other chapters. 

In this chapter, you will work with a finished map in ArcGIS Pro that has the locations of 

urgent health-care clinics in Allegheny County, Pennsylvania. These clinics are (1) federally 

qualified health centers (FQHCs) that provide subsidized health care for underserved pop-

ulations and (2) nonsubsidized clinics that provide health care (named urgent care clinics 

in this book). You will become familiar with the software, learn how the map works, and 

analyze the locations of both types of health-care clinics to see whether they are sited in 

appropriate locations.
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Tutorial 1-1: Getting an overview of ArcGIS Pro

Before starting work on your computer, review this terminology for ArcGIS Pro 
projects and spatial data. 

•	 A feature class is the basic building block for displaying geographic features 
on a map. You can think of a feature class as a homogeneous layer on a map. 
Feature classes are vector data and have corresponding attributes for each 
feature. For example, you will work with a point feature class named FQHC 
Clinics that has points for all FQHCs in Allegheny County. In addition, 
Streets is a line feature class that has centerlines for all streets in the county, 
and Municipalities is a polygon feature class that has boundaries for all 
municipalities in the county.

•	 A raster dataset (or raster) is a major type of spatial data. A raster is an image 
made up of pixels — squares so small that you can’t see them until you zoom 
in. A common example of a raster is satellite imagery. A raster encoded with 
geographic coordinates can be used as a layer in a map.

•	 A file geodatabase is a folder with the extension .gdb that stores feature 
classes, raster datasets, and other related files. Although many other file 
formats are used for storing spatial data, the file geodatabase is a preferred 
Esri format. The data used in the Tutorial 1-1 project is in the Chapter1 file 
geodatabase, stored in the Chapter1\Tutorials folder on your computer. 

•	 A project is a file with the extension .aprx that contains one or more maps and 
related items. For example, you’ll open Tutorial1-1.aprx after this intro-
duction. This project has two maps, Health Care Clinics and Health Care 
Clinics_3D, plus other project items. A project doesn’t contain spatial data 
(such as the feature classes you may use on your maps) — it simply pulls in 
spatial data that’s stored elsewhere, such as in a file geodatabase. A project 
can be stored in a location of your choice. 

Set up the Tutorial 1-1 project

You’ll start by opening a project in ArcGIS Pro. The opening map has 12 layers avail-
able for Allegheny County but only one turned on — a layer for population density 
by census tract from the 2020 census. The city of Pittsburgh is in the center of the 
county.

1.	 Browse to links.esri.com/GISTforPro3.1Data to download the tutorial data for 
the book. Download and extract the files to your local drive.

2.	 Start ArcGIS Pro on your computer.
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3.	 Sign in with your ArcGIS account username and password. If you don’t already 
have a license, see the licensing options at the beginning of this chapter in the 
section “Essentials for Getting Started: Licensing the Software.”

4.	 Click Open Another Project. In the Open Project pane, browse to \EsriPress​
\GISTforPro\Chapter1\Tutorials, and double-click Tutorial1-1.aprx. 

The project opens and displays a map called Health Care Clinics. 

5.	 On the Map tab, click Bookmarks > Allegheny County. 

The bookmark centers the map to fill the view.

6.	 In the Contents pane, scroll down to see the legend for the Population Density 
layer. 

This groups the census tracts into nine classes. A white-to-black color scheme 
shows how many people live there per square mile, in increments of 1,000.

7.	 On the Project tab, click Save Project As, browse to Chapter1\Tutorials, and 
save the project as Tutorial1‑1YourName​.aprx (substitute your name for 
YourName). 

You’ll generally open and save projects for each chapter this way. If you make a 
mistake, you can start again with the original project.

Copyright © 2023 Esri. All rights reserved.
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Add and remove a basemap

A basemap is a layer that helps orient users to a location. Map designers place 
additional feature classes on top of a basemap to provide specific information for 
visualization, analysis, or problem solving. Although you can create your own base-
map, Esri provides the basemaps you’ll use in this book. These basemaps come from 
ArcGIS Online. 

1.	 On the Map tab, in the Layer group, click Basemap. 

You’ll see a variety of basemaps — available basemaps depend on licensing.

2.	 Click the Streets basemap to add the basemap to your map. 

The Population Density feature class covers most of the Streets basemap. 

Because the basemap doesn’t add useful information in this case, you’ll remove 
it.

3.	 Scroll to the bottom of the Contents pane, right-click World Street Map, and 
click Remove.
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Turn layers on and off 

The order in which feature classes are drawn is shown in the Contents pane. The fea-
ture class at the bottom of the pane is drawn first, and each layer above it is drawn in 
turn on top of the preceding layer until you reach the top of the list. Feature classes 
that cover large areas, such as Population Density, must go on the bottom. Other 
feature classes that may be covered by other layers — such as FQHC Clinics, which 
has points — must go higher in the list to be visible.

1.	 In the Contents pane, scroll down to see the legend for Population Density. 

The check mark on the left of Population Density indicates that the feature class 
is turned on. 

2.	 In the Contents pane, check the boxes for Urgent Care Clinics, FQHC Clinics, 
and Poverty Risk Area. 

The three feature classes you just turned on are the subject of this map and 
show the locations of urgent care clinics relative to poverty risk areas. Right 
away, you’ll notice that the subsidized FQHC clinics tend to be concentrated in 
areas of high population density (urban) and poverty risk, whereas the non-
subsidized urgent care clinics are mostly spread out in areas of low population 
density (suburbs). Areas inside the poverty risk area polygons have high propor-
tions of poor populations, as determined by the number of households below 
the poverty income threshold (using average American Community Survey data 
for the five-year period ending in 2019). The locations of FQHC and urgent care 
clinics are from 2022.

YOUR TURN
The Your Turn assignments in this book ask you to repeat the steps 

just completed but with some modifications. These assignments help 

you retain the workflows in the steps. Often, you’ll need to complete 

the Your Turn assignments so you can use their results in the next 

tutorial steps, so don’t skip Your Turn assignments.

For this Your Turn assignment, add and remove several basemaps 

of your choice. You’ll notice that some basemaps, such as Light Gray 

Canvas, add a labeling layer at the top of the Contents pane. When 

you remove those basemaps, remove the corresponding labeling 

layer, too.
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3.	 Turn on feature classes that provide the spatial context of where subject features 
are located: Pittsburgh, Allegheny County, Rivers, and Streets. 

Streets, an important spatial context feature class, won’t display until the map 
is zoomed in to a small area (you’ll learn about zooming later in this chapter). 
There are too many detailed streets for viewing at full extent. 

To make the point that ArcGIS Pro draws from the bottom up in the Contents 
pane, you’ll temporarily drag Population Density higher to cover other feature 
classes.

Reorder feature classes in the Contents pane

1.	 Drag Population Density to the top of the Contents pane, under Health Care 
Clinics. 

Now this feature class covers all other feature classes in the map.

2.	 Drag Population Density back to directly above the Poverty Density feature 
class. 

3.	 At the top of the screen, above the ribbon, click the Save button. 

Some ribbon buttons don’t have labels. To identify the button you need, posi-
tion the pointer above the button to view a pop-up ScreenTip. The Save button 
saves the entire project.

Copyright © 2023 Esri. All rights reserved.
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Examine the Catalog pane, and open and export a map layout 

The Catalog pane provides access to all components in an ArcGIS Pro project.

1.	 On the View tab, in the Windows group, click Catalog Pane. The Catalog pane 
appears. 

2.	 If the pane isn’t docked on the right side of the ArcGIS Pro window, right-click 
the top of the pane, and click Dock.

3.	 In the Catalog pane, click the arrows on the left of both the Maps and the 
Layouts folders to expand the folders, revealing what’s been built so far for this 
project. 

You are viewing the Health Care Clinics map, but you’ll also view a 3D version 
of the same map at the end of this chapter.

Copyright © 2023 Esri. All rights reserved.
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4.	 In the Catalog pane, under Layouts, double-click FQHC and Urgent Care 
Clinics. 

ArcGIS Pro displays the layout on a new tab, next to the tab for the map. The 
map is the main element of a layout, which also includes the title, legend, and 
scale bar. You’ll learn about making layouts later.

5.	 At the upper right of the Catalog pane, click the Auto-Hide button (the pushpin) 
to temporarily hide the pane. 

You can restore and hide the Catalog pane as needed by clicking the Catalog 
button. 

Next, you’ll use a tool to export the map layout as an image file that can be used 
in a report or presentation or on a website. ArcGIS Pro has hundreds of tools, 
and you’ll use many of them in this book. Each tool has a dialog box (a pane) 
for values (parameters) you need to add to run the tool, generally by choosing 
values from lists or entering values by typing.

6.	 On the Share tab, in the Output group, click Export Layout. 
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The Export Layout tool pane opens, ready for you to add and type parameters as 
needed to export an image file of the layout.

a.	 On the File Type drop-down menu, click PNG.
b.	 For Name, click the Browse button, browse to save the file to your desk-

top, and rename it FQHCAndUrgentCareClinics.png. 
c.	 For Resolution, type 150.
d.	 On the Color Depth drop-down menu, click 24-bit True Color.
e.	 Click Export to run the tool.

7.	 On your desktop, double-click FQHCAndUrgentCareClinics.png to open the 
image in a photo viewer. 

8.	 Examine the image, and close the photo viewer.

9.	 Click Save to save your project. 

Copyright © 2023 Esri. All rights reserved.
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YOUR TURN
Next to the FQHC and Urgent Care Clinics layout tab, click the Health 

Care Clinics map tab to activate it. In the Contents pane, turn on the 

FQHC Buffer and Urgent Care Clinics Buffer feature classes. FQHC 

Buffer shows circles with a one-mile radius, and Urgent Care Clinics 

Buffer shows circles with a five-mile radius, each drawn around its 

respective clinics. Allegheny County, outside Pittsburgh, consists 

mostly of suburbs for which expected travel distances are greater than 

distances in urban areas. The buffers are partly transparent, allowing 

you to see the population density below them. By comparing the 

clinic service areas and the population density, you can get an idea 

of how services are apportioned. Next, switch back to the layout tab. 

ArcGIS Pro has already added the newly displayed feature classes to 

the layout map and legend. When you’ve finished, save your project.
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Tutorial 1-2: Navigating ArcGIS Pro

In ArcGIS Pro, you can zoom to any part of a map, drag (pan) the map to a different 
location, and zoom in or out. You can set some feature classes, such as streets, to 
appear only when you are zoomed to a certain scale, and you can set your scale to 
turn off other feature classes. You can access preset locations and scales using spa-
tial bookmarks. You can read the attribute data of any feature by clicking the feature 
to show a pop-up with that information. Last, you can search for features by using 
attribute values, such as the name of a street.

Set up the Tutorial 1-2 project

1.	 Above the ribbon, at the top left, click Open, and browse to Chapter1\Tutorials.

2.	 Open Tutorial1-2.aprx, and save the project as Tutorial1-2YourName.aprx in 
Chapter1\Tutorials.

Use a pop-up window

1.	 On the Map tab, in the Navigate group, click Full Extent, and click the Explore 
button.

2.	 On the map, click the urgent care clinic farthest to the north to show a pop-up 
window with attribute data for that feature. Click the pop-up’s website hyper-
link, and read what you want about that clinic. When you’ve finished, close your 
browser.

3.	 Drag the pop-up off your map, to the side. 

4.	 Point to each of the buttons in the lower right of the pop-up to read what they 
do, and click the Zoom to This Feature button several times. 

Copyright © 2023 Esri. All rights reserved.
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The map centers and zooms in on the clinic. If you zoom in close enough, the 
Buffers and Population Density feature classes turn off, the Street feature class 
turns on, and the clinic is labeled. If you zoom in even farther, the streets are 
labeled. These feature classes and labels have visibility ranges that control 
whether they are visible. 

5.	 Close the pop-up, and zoom to the full extent. 

Zoom in

1.	 Position the pointer over the point where the three rivers join in the middle of 
the map, and use the wheel button (or Plus key) to zoom in on the map, stop-
ping several times before zooming in more. 

The wheel button (or Minus key) is used to zoom out.

2.	 Scroll up and down in the Contents pane. 

Feature classes not drawing at this scale have gray check marks, whereas feature 
classes that are drawn have black check marks.

3.	 Click and pan the map to a new location. 

Your pointer is automatically in pan mode when the Explore button (Map tab, 
Navigate group) is activated. You can also use the arrow keys on your keyboard 
to pan the map. If you have a touch screen, tap and slide the map to pan.

4.	 On the Map tab, in the Navigate group, click the Previous Extent button 
(left-pointing arrow) a couple of times. 
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Clicking this button moves you back through the sequence of steps you’ve 
taken. There’s also a Next Extent button (right-pointing arrow) used to advance 
forward through your sequence of steps.

5.	 Zoom to the full extent. 

Zoom in to a raster feature class

All the layers, except the Poverty Density layer, are vector data, made up of points, 
lines, or polygons. ArcGIS Pro draws vector data on the fly from stored geometry 
and drawing instructions, including how the map designer wants them symbolized 
(such as the brown square symbols for Urgent Care Clinics). Rasters, however, are 
image data (for example, JPEG and TIFF) and are rendered pixel by pixel.

1.	 Turn the feature classes on or off as needed, so that only the following feature 
classes are on: Poverty Risk Area, Pittsburgh, Allegheny County, Rivers, Streets, 
and Poverty Density. Hint: Press and hold the Ctrl key and click a feature class 
check box to turn all feature classes on or off. Then adjust for the desired map. 

Poverty Density shows households below the poverty income level per square 
mile. The raster is rectangular, as are all raster datasets. If you look closely, 
you’ll see that the Poverty Risk Area feature class (which is drawing on top of 
the raster) appears to be encircling the deep-red areas of the Poverty Risk raster 
dataset. 

2.	 Zoom in to the center of the map until you can see the individual pixels of 
Poverty Density. 

Copyright © 2023 Esri. All rights reserved.
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In the figure, the pixels of the Poverty Density raster map are next to the 
smooth vector edge of a Poverty Risk Area polygon.

3.	 Zoom to the full extent, and turn on all feature classes except Municipalities 
and Poverty Density.

Use bookmarks

Spatial bookmarks allow you to zoom to preset map views.

1.	 On the Map tab, in the Navigate group, click the Bookmarks button. 

Three bookmarks are available for the open map: Allegheny County, Poverty 
Areas, and Pittsburgh East End. Also available are two bookmarks for a 3D map 
that you’ll use in tutorial 1-4.

2.	 Click the Poverty Areas bookmark. 

The map zooms to that area. Your map may have different feature classes 
displayed, depending on the size of your computer’s screen and map window, 

Copyright © 2023 Esri. All rights reserved.
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because the thresholds that switch feature class displays on and off depend on 
the ratio of feature sizes on the screen to actual feature sizes on the ground. 
You’ll learn more about map scale in chapter 2.

3.	 In the lower right of the map, zoom in and pan to the poverty risk area there 
until streets appear. 

An alternative is to press Shift, and draw a rectangle around the area desired for 
closer viewing.

4.	 On the Map tab, in the Navigate group, click Bookmarks > New Bookmark.

5.	 In the Create Bookmark window, for Name, type McKeesport Poverty Area, 
and click OK.

6.	 Click the Allegheny County bookmark, and then try your new bookmark.

7.	 Click Bookmarks > Manage Bookmarks.

8.	 In the Bookmarks pane, alphabetize the Health Care Clinics bookmarks by 
dragging to rearrange them.

9.	 Close the Bookmarks pane.

10.	 Zoom to the full extent.
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Search for a feature

Next, you’ll use the ArcGIS Pro query builder for Structured Query Language (SQL) 
queries. SQL is the standard language for querying tabular data. In this quick pre-
view, you’ll search for locations based on their attribute data values. 

1.	 In the Contents pane, clear the Population Density check box, and check the 
Municipalities check box.

2.	 Right-click Municipalities to open the menu, and click Attribute Table. 

Every vector feature class has an attribute table, and each feature (point, line, or 
polygon) of a feature class has a record or row of data.

3.	 On the Map tab, in the Selection group, click the Select by Attributes button. 

The Select by Attributes tool appears. Municipalities is already selected as the 
input. In the box for building the query, the SQL expression starts with the 
word Where. Complete the query as follows:

a.	 After Where, click the down arrow, and click Name.
b.	 Keep Is Equal To.
c.	 Click the last down arrow, and click McKees Rocks.

d.	 Click OK. 

The result is that the McKees Rocks record and feature are selected. You will 
complete the next two steps to see the record and feature.

4.	 At the bottom left of the Municipalities attribute table, click the Show Selected 
Records button . 

Only the selected record is visible now.
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5.	 In the Contents pane, right-click Municipalities, point to Selection, and click 
Zoom to Selection.

6.	 At the top of the table, click the Clear button, and close the attribute table.

7.	 Clear the Municipalities check box, and check the Population Density check 
box.

Tutorial 1-3: Working with attribute data 

Attributes play a major role in GIS. Besides providing data needed to solve a prob-
lem or investigate spatial patterns, attributes allow you to search for useful informa-
tion and mapped features. 

Open a table

1.	 Open Tutorial1-3.aprx, and save the project as Tutorial1-3YourName.aprx.

2.	 In the Contents pane, right-click FQHC Clinics, and click Attribute Table. 

YOUR TURN
Search for an FQHC, the Birmingham Free Clinic, and zoom to that 

clinic. Hint: In the Select by Attributes pane, for Input Rows, make sure 

you have selected FQHC clinics. When you finish, clear your selec-

tions, close any open panes or tables, and zoom to the full extent. 

Save your project.

Copyright © 2023 Esri. All rights reserved.
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The table shows 19 FQHC clinics with name and address data, latitude and 
longitude coordinates, and website addresses. The first six records are shown in 
the image.

3.	 If you can’t read the full cell contents, adjust the column widths in the table by 
positioning the pointer between column names on the top row until the pointer 
becomes a two-headed arrow, and click and adjust by moving the column 
boundary left or right. 

You can also double-click when you see the two-headed arrow to automatically 
resize the column widths.

4.	 In the table, drag the Website column before Latitude. 

5.	 Right-click the Name column heading, and click Sort Ascending. 

6.	 Close the FQHC Clinics table, and save the project.

YOUR TURN
Turn off all layers, and then turn on Population Density. Open the attri-

bute table for Population Density. The GeoID attribute is a geocode 

(unique identifier or primary key) assigned to census tracts by the US 

Census Bureau. Attributes of interest are Population (2020 popula-

tion), AreaSqMiles, and PopDensity, which is Population/Area. Using 

sorting, find the tract with the highest population density, 29,492.7 

persons per square mile. Select that record (click the gray square on 

its left). You can see the corresponding census tract in the selection 

color (cyan) on the map. Click the Clear button at the top of the table. 

Close the table when you’ve finished.
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Work with the fields view of an attribute table

You can change the order of attributes (columns) in a table, change the names and 
displayed names (aliases) of attributes, see the data type of attributes, delete attri-
butes, and make only certain attributes visible to the user — all using the Fields view 
of a table.

1.	 In the Contents pane, turn off Population Density, and turn on Municipalities.

2.	 Open this feature class’s attribute table. 

All attributes are those provided by the Census Bureau. You’ll learn more about 
census data later. The only attributes you need to see and use are GeoID and 
Name (municipality name). Other attributes are needed by ArcGIS Pro for pro-
cessing — namely, ObjectID, Shape, Shape_Length, and Shape_Area — and the 
rest can be deleted or hidden from view.

3.	 In the upper right of the table, click the Menu button (three stacked lines) , and 
click Fields View. 

A new tab opens with the field of Municipalities and their properties. 

4.	 Drag the MTFCC row using its gray, left-most box to the row above STATEFP. 

That action, when saved, permanently rearranges the attribute table so that 
MTFCC is the first row.

Next, you’ll delete a field from the table. Be careful when deleting fields so that 
you don’t delete fields you may need later.

5.	 Right-click the box for the STATEFP row, and click Delete. 

ArcGIS Pro strikes through text values in that row to indicate that the field will 
be deleted when table changes are saved.
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6.	 Turn off visibility for all fields except GeoID and Name. 

Hint: Uncheck the Visible box at the top of the first data column, and check 
GeoID and Name to make them visible.

7.	 For the Name field, under the Alias column, type Municipality Name. 

8.	 On the ribbon, on the Fields tab, in the Changes group, click Save, close the 
Fields view, and sort the attribute table in ascending order by municipality 
name. 

9.	 Close the attribute table.

Select records and features of a map feature class

1.	 Keep Municipalities turned on, and turn on FQHC Clinics.

2.	 Open the attribute table for FQHC Clinics, and sort in ascending order by 
name.

3.	 In the table, on the left of row 1, click the gray square cell, and drag down 
through row 6. 

YOUR TURN
In the Streets attribute table, give the FullName field the alias 

Street Name, and make only the following fields visible: FullName, 

LFromAdd, LToAdd, RFromAdd, RToAdd, ZipL, and ZipR. Save your 

edits, and close the Fields view and attribute table.
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You have selected six of the 19 FQHC Clinics records in the table and high-
lighted their point symbols on the map (in cyan), demonstrating the linkage 
between records and features. Many GIS functions work with selected subsets 
of records and features.

4.	 At the top of the attribute table, click Clear.

5.	 At the top of the Contents pane, click List by Selection.

6.	 Clear the check boxes as needed so that only Urgent Care Clinics and FQHC 
Clinics are turned on. 

Now when you click the map, you can select only clinics and not mistakenly 
select other features.

7.	 At the top of the Contents pane, click the List by Drawing Order button.

8.	 On the Map tab, in the Selection group, click Select.

9.	 Press Shift, and on the map, individually select any five FQHCs. 

Five corresponding records are selected in the table.

10.	At the top of the table, click Switch. 

Copyright © 2023 Esri. All rights reserved.
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All the records except for the five FQHCs that were originally selected are now 
selected. 

11.	 Clear the selection.

Obtain summary statistics using a tool

ArcGIS Pro has hundreds of tools for processing geographic and related data. You 
can search for a tool, fill out its form to specify inputs, set parameters that control 
algorithm behavior, and name and specify where to store outputs. The Summary 
Statistics tool computes common statistics (for example, minimum, maximum, 
mean, and standard deviation), and writes the results to a new table. Obtaining and 
studying summary statistics for attributes of interest are among the first steps of any 
analysis. 

1.	 In the Contents pane, turn off FQHC Clinics, and turn on Population Density.

2.	 On the Analysis tab, click the Tools button.

3.	 In the Geoprocessing pane, click Toolboxes.

4.	 Expand Analysis Tools > Statistics. 

YOUR TURN
Using the Selection tool, draw a rectangle around some FQHCs on the 

map. All FQHCs within the rectangle are selected. Press and hold Shift, 

and draw a different rectangle. More FQHCs are added. Press and hold 

Ctrl, and click an already selected FQHC. That FQHC gets unselected, 

and all other selected FQHCs remain selected. Press and hold Shift, 

and reselect the FQHC you just unselected. That FQHC is added back 

to the selection. Clear the selections, and close the table. This assign-

ment showed that you can select any subset of features.
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If you know the name of a tool, you can open it by 
clicking the Tools button, and in the Find Tools search 
box in the Geoprocessing pane, typing the name or 
partial name of the tool.

5.	 Click the Summary Statistics tool to open it, and type or make the selections as 
shown. 

Once you start applying settings, ArcGIS Pro automatically chooses your 
project’s file geodatabase, Chapter1.gdb, and names the output table 
PopulationDensity_Statistics. You can override those defaults if desired. Make 
sure that Case Field is clear. 

a.	 For Input Table, click Population Density.
b.	 For Field, click PopDensity.
c.	 For Statistic Type, click Minimum.
d.	 Repeat this process three more times, clicking additional PopDensity 

Fields. For Statistic Type, click Maximum, Mean, and Standard Deviation, 
respectively.

6.	 Click Run.
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7.	 In the Contents pane, scroll down, right-click the PopulationDensity_Statistics 
table, and click Open. 

At least one tract has no population, so the minimum population is zero, the 
maximum population density is 29,492.7, the mean population density is 
4,516.6 persons per square mile, and the standard deviation is 4,178.

8.	 Close the table, and save your project.

Tutorial 1-4: Symbolizing maps

This tutorial introduces you to the basics of symbolizing maps. You’ll change the 
symbols of feature classes, including the color and size. You’ll label features with 
their name, choose a font and size, and place a halo around labels to improve read-
ability. You’ll add a feature class to the map from a geodatabase, symbolize it, and 
remove it from your map. 

Set up the Tutorial 1-4 project

1.	 Click Open, and browse to Chapter1\Tutorials.

2.	 Open Tutorial1-4.aprx, and save the project as Tutorial1-4YourName.aprx in 
Chapter1\Tutorials.

Symbolize feature classes

1.	 In the Contents pane, right-click FQHC Clinics, and click Symbology. 

The Symbology pane appears. The current symbology is Single Symbol with a 
green circle and a dark-gray boundary.

2.	 In the Symbology pane, click the current symbol (the green circle). 

A gallery of symbols opens.

3.	 Click Circle 4. 

The FQHC symbols on the map immediately change to Circle 4. 

4.	 At the top of the Symbology pane, click Properties.
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5.	 Under Appearance, change the color to Leaf Green (seventh column, fifth row), 
change the size to 8 pt, and click Apply. 

Label a feature class

You will label a feature class using one of its attributes.

1.	 In the Contents pane, turn off Population Density, Urgent Care Clinics Buffer, 
and FQHC Buffer. Turn on and select Municipalities. 

Because you selected Municipalities in the Contents pane, several contextual 
tabs appear on the ribbon to give you access to additional functionality for 
modifying the feature class. 

2.	 Click the Labeling tab.

3.	 On the far left, under Labeling, click the Label button to turn labeling on for 
Municipalities. 

Municipalities are automatically labeled with their Name attribute. Next, you’ll 
make the labels less prominent.

YOUR TURN
Symbolize Poverty Risk Area with a 2-pt line and the 

Poinsettia color (second column, fourth row). Close the 

Symbology pane when you’ve finished.
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4.	 In the Text Symbol group, change the font to 7 pt, and choose a dark gray. 

5.	 In the Text Symbol group, in the lower right, click the Dialog Launcher button. 

6.	 In the Label Class pane, the Symbol tab is active. Scroll down, and expand Halo. 
Set the following parameters, and then click Apply:

a.	 Halo Symbol: White square (White fill)
b.	 Outline Color: No Color
c.	 Outline Width: 0.75 pt

7.	 Zoom to the western part of the county that’s centered on the river. 

In effect, the halo erases features surrounding the label so that the label is easy 
to read.

8.	 Turn Municipalities off, and zoom to the full extent.

Add and remove feature classes

1.	 Open the Catalog pane. Hint: On the View tab, click Catalog Pane.

2.	 Expand Databases, and expand Chapter1.gdb. Locate Feature Class Parks, and 
drag it onto the map. 

Feature Class Parks is added to the Contents pane.

3.	 In the Contents pane, reorder Parks to be just above Population Density. 

4.	 Click the Parks symbol (rectangle under Parks) to open the Symbology pane.
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5.	 In the Symbology pane, click the Gallery tab, scroll down, and click the Park 
symbol (light green with no boundary).

6.	 Zoom to the Pittsburgh East End bookmark. Zoom in until streets appear.

7.	 In the Contents pane, right-click Parks, and click Remove. 

8.	 Zoom to the full extent, and save your project.

View and navigate a scene

The Tutorial 1-4 project file has a 3D version of Population Density with population 
density by census tract extruded vertically, which you’ll open next. The contrast in 
population density within an urban area is difficult to appreciate using color sym-
bology. In 3D, the differences are impressive.

1.	 In the Catalog pane, expand Maps, double-click Health Care Clinics_3D, and 
wait (several seconds) until the census tracts appear. 

You won’t see the 3D effect until you tilt the view in the next step.

2.	 If you are using a mouse, use the right and left buttons to navigate. If your 
mouse has a scroll wheel, use that, as well. If you are using the keyboard to 
navigate, press V and the down arrow key, and tap the down arrow key until the 
map tilts upward. 
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The tremendous differences in population density are apparent using the scene. 

3.	 Press V and the other arrow keys to navigate. Press V and the Plus or Minus key 
to zoom in or out. 

4.	 Press the N key to reorient the map with north up.

5.	 Press P to look straight down at the map.

6.	 Save and close your project. 

Assignments 

This chapter has assignments to complete that you can download with data from 
ArcGIS Online at links.esri.com/GISTforPro3.1Assignments. 
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